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2. Ειζαγφγή 
 

Ζ δηαξθώο απμαλόκελε δήηεζε ειεθηξηθήο ελέξγεηαο ζηηο ζύγρξνλεο θνηλσλίεο δεκηνπξγεί ηελ 

αλάγθε γηα κεγαιύηεξε παξαγσγή θαη ηζρπξόηεξα δίθηπα κεηαθνξάο. Σα ήδε ππάξρνληα δίθηπα 

ειεθηξηθήο ελέξγεηαο δελ θαιύπηνπλ πιήξσο ηηο πξνϋπνζέζεηο γηα αζθαιή κεηαθνξά ηεο 

ελέξγεηαο. Γεκηνπξγείηαη έηζη ε αλαγθαηόηεηα γηα ηελ νινέλα θαη ζπρλόηεξε ρξήζε 

πξνγξακκάησλ Ζ/Τ γηα ηελ αλάιπζε ησλ δηθηύσλ ειεθηξηθήο ελέξγεηαο. Σα πξνγξάκκαηα απηά 

ρξεζηκνπνηνύλ ζπλήζσο κεζόδνπο πξνζνκνίσζεο θαη εθηόο ηεο επίιπζεο ησλ δηθηύσλ 

πξνηείλνπλ θαη βέιηηζην ηξόπν ιεηηνπξγίαο ηνπο. 

 

Γηα λα αληηιεθζνύκε ηε κεγάιε ρξεζηκόηεηα ηέηνησλ πξνγξακκάησλ αλάιπζεο ΢ΖΔ, αξθεί λα 

ζεκεηώζνπκε ηελ πνιππινθόηεηα ησλ ζπζηεκάησλ θαη ηα ζύλζεηα πξνβιήκαηα πνπ πξέπεη λα 

επηιύζνπκε. ΢ε ό,ηη αθνξά γηα παξάδεηγκα ζην ειιεληθό δηαζπλδεδεκέλν ζύζηεκα (ην νπνίν 

είλαη αξθεηά κηθξό), ε ειεθηξηθή ελέξγεηα παξάγεηαη από πεξίπνπ 80 γελλήηξηεο, 

εγθαηεζηεκέλεο ηζρύνο 12.000 MW. Οη γξακκέο κεηαθνξάο πςειήο ηάζεο έρνπλ κήθνο πεξίπνπ 

9811 km, νη κέζεο ηάζεο 76544 km θαη νη ρακειήο ηάζεο 87935 km. Αθόκα, ζην βαζκό πνπ δελ 

ππάξρεη ηξόπνο απνζήθεπζεο ηεο ειεθηξηθήο ελέξγεηαο, απηή ζα πξέπεη λα παξάγεηαη ηε ζηηγκή 

πνπ δεηείηαη αιιά ηαπηόρξνλα λα επηηπγράλεηαη ε νηθνλνκηθόηεξε ιεηηνπξγία, λα κελ 

παξαηεξείηαη δειαδή ζπαηάιε ελέξγεηαο ή ρξεκάησλ. ΢πλεπώο, είλαη απαξαίηεηεο κέζνδνη 

πξόβιεςεο θνξηίνπ θαη ειέγρνπ. Θα πξέπεη αθόκα λα ζπλππνινγίζνπκε όηη νη ζεξκηθνί ζηαζκνί 

απαηηνύλ γηα ηελ θαηαζθεπή ηνπο ηνπιάρηζηνλ 3-5 ρξόληα. Έηζη νη απνθάζεηο γηα επέθηαζε ησλ 

δηθηύσλ ζα πξέπεη λα αθνξνύλ κηα πεξίνδν ηνπιάρηζηνλ 15 εηώλ. Σέινο, αλ ιάβνπκε ππόςε καο 

ην γεγνλόο όηη γηα έλα ζρεηηθά κηθξό ζύζηεκα απαηηείηαη ε επίιπζε πεξίπνπ 2500 κε γξακκηθώλ 

αιγεβξηθώλ εμηζώζεσλ, αληηιακβαλόκαζηε όηη ε ρξήζε ςεθηαθώλ πξνγξακκάησλ είλαη όρη απιά 

ρξήζηκε αιιά αλαγθαία. 

 

Οη ειεθηξνληθνί ππνινγηζηέο ρξεζηκνπνηνύληαη ζε όια ηα ζηάδηα ηνπ θύθινπ ηεο ειεθηξηθήο 

ελέξγεηαο (παξαγσγή, κεηαθνξά, δηαλνκή). ΢ην επίπεδν ηνπ ζηαζκνύ παξαγσγήο είλαη θπξίσο 

ρξήζηκνη γηα ηελ παξαθνινύζεζε θαη εθηέιεζε ιεηηνπξγηώλ ειέγρνπ. ΢πγθεληξώλνπλ θαη 

επεμεξγάδνληαη δεδνκέλα από ηα ππνζπζηήκαηα, πξνεηδνπνηνύλ όηαλ ζπγθεθξηκέλεο κεηαβιεηέο 

είλαη εθηόο νξίσλ (ζεξκνθξαζίεο, πηέζεηο, ξνέο), ππνινγίδνπλ δείθηεο απόδνζεο γηα ην ζηαζκό 

αιιά θαη ηα επηκέξνπο ππνζπζηήκαηα. 

 

Ζ θύξηα ρξεζηκόηεηα ησλ ειεθηξνληθώλ ππνινγηζηώλ αθνξά ζηνλ θεληξηθό έιεγρν όισλ ησλ 

ιεηηνπξγηώλ ηνπ ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο. ΢ηα θέληξα ειέγρνπ ελέξγεηαο, νη ρεηξηζηέο 

ρξεζηκνπνηνύλ Ζ/Τ γηα ηελ θαηαλνκή ηνπ θνξηίνπ ζηηο γελλήηξηεο ηνπ ζπζηήκαηνο. 

Παξαθνινπζνύλ θαη ειέγρνπλ ηα δίθηπα κεηαθνξάο, πξνεηνηκάδνληαη γηα ηελ αληηκεηώπηζε 

βιαβώλ (νη νπνίεο ζπκπεξηιακβάλνπλ θαη απόηνκε κεηαβνιή ηεο δήηεζεο), πξνγξακκαηίδνπλ ηε 

ζπληήξεζε ησλ ζηνηρείσλ (ώζηε λα απνθεπρζεί ε πεξίπησζε κεξηθνύ ή νιηθνύ blackout). ΢ηα 

θέληξα ειέγρνπ ησλ ζπζηεκάησλ δηαλνκήο, νη Ζ/Τ ρξεζηκεύνπλ ζηελ παξαθνινύζεζε ησλ 

δηθηύσλ κέζεο ηάζεο θαη ησλ θέληξσλ δηαλνκήο ππό νκαιέο ή έθηαθηεο θαηαζηάζεηο (άζρεκεο 

θαηξηθέο ζπλζήθεο ή άιινπ ηύπνπ δηαηαξαρέο πνπ πξνθαινύλ δηαθνπή ηξνθνδόηεζεο ησλ 

θαηαλαισηώλ). Σέινο, ππνινγηζηέο ρξεζηκνπνηνύληαη επξέσο γηα ηελ αλάπηπμε θαη ζρεδίαζε 

ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο. 

 

Μηα αθόκα ζεκαληηθή παξάκεηξνο ηεο ρξήζεο ειεθηξνληθώλ ππνινγηζηώλ γηα ηε κειέηε θαη 

αλάιπζε ΢ΖΔ είλαη ε εθπαηδεπηηθή ηνπο ρξεζηκόηεηα, αθελόο ζην επίπεδν ηεο παξαγσγηθήο 
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δηαδηθαζίαο θαη αθεηέξνπ ζηα εθπαηδεπηηθά ηδξύκαηα. Μέζσ ησλ πξνζνκνησηώλ εθπαίδεπζεο 

ρεηξηζηώλ εθπαηδεύνληαη ζε λέα πξνγξάκκαηα θαη δεδνκέλα όρη κόλν νη λένη κεραληθνί αιιά θαη 

έκπεηξνη ρξήζηεο. Αθόκα, γηα ηηο αλάγθεο ηεο αξρηθήο εθπαίδεπζεο, έρνπλ δεκηνπξγεζεί 

πξνζνκνηώζεηο ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο ζε πξώηκν ζηάδην, ζε απιό επίπεδν. Σέηνηα 

εθπαηδεπηηθά παθέηα ζηνρεύνπλ ζηελ θαηαλόεζε ελλνηώλ θαη κεζόδσλ επίιπζεο. Άιινηε 

παξέρνπλ κόλν ηε δηαδηθαζία ππνινγηζκώλ θαη άιινηε παξέρνπλ ηελ πιήξε απεηθόληζε ησλ 

απνηειεζκάησλ. Γελ έρνπλ όκσο ζπλήζσο ηηο δπλαηόηεηεο επίιπζεο πνιύπινθσλ πξνβιεκάησλ, 

πνπ αληηκεησπίδνληαη από επαγγεικαηηθά παθέηα 

 

3. Διαθέζιμα προγράμμαηα 
 

Τπάξρνπλ κηα ζεηξά από πξνγξάκκαηα, γηα εθπαηδεπηηθή θπξίσο ρξήζε, πνπ απεπζύλνληαη ζε 

θνηηεηέο γηα ηελ θαηαλόεζε θαη εκβάζπλζε ζε έλλνηεο θαη θαηλόκελα πνπ εκπιέθνληαη ζηα 

δίθηπα δηαλνκήο ειεθηξηθήο ελέξγεηαο, αιιά θαη γηα (εκη)επαγγεικαηηθή ρξήζε πνπ 

απεπζύλνληαη ζε λένπο κεραληθνύο. ΢ε ό,ηη αθνξά ζηα επαγγεικαηηθά παθέηα, δύν από ηα πην 

δηαδεδνκέλα είλαη ηα CYMFLOW θαη ην PSS/E. Σν πξώην αλαθέξεηαη ζηελ αλάιπζε ξνήο 

θνξηίνπ ζε ηξηθαζηθά δίθηπα ειεθηξηθήο ελέξγεηαο, θαη απεπζύλεηαη θπξίσο ζε βηνκεραλίεο γηα 

ηνλ έιεγρν ηνπ εζσηεξηθνύ δηθηύνπ δηαλνκήο θαη ηε δηαζύλδεζή ηνπ κε ην δίθηπν κεηαθνξάο. 

Απνηειεί εξγαιείν γηα ηα βηνκεραληθά ζπζηήκαηα ηζρύνο κε αλαιπηηθέο επηινγέο θαη 

ελαιιαθηηθέο ηερληθέο επίιπζεο (δπλαηόηεηα αλάιπζεο δηθηύσλ κε ρηιηάδεο δπγνύο, πνιιαπινί 

δπγνί ηαιάλησζεο, ηαπηόρξνλεο ιύζεηο γηα πνιιά δίθηπα λεζίδσλ, δπλαηόηεηα νξηζκνύ νξίσλ, 

γξαθηθόο ηξόπνο αλαπαξάζηαζεο κε πνηθίιεο εύρξεζηεο δπλαηόηεηεο, δπλαηόηεηα έληαμεο 

αηνιηθώλ ζπζηεκάησλ θιπ). Αθόκα πεξηιακβάλεη έλα εξγαιείν γηα ηελ αλάιπζε πηζαλώλ 

δηαηαξαρώλ, πνπ ππνζηεξίδεη απεξηόξηζην αξηζκό ζελαξίσλ, απηόκαηε θαηάηαμε, αλαδήηεζε θαη 

επίιπζε δηαηαξαρώλ θαη έλα άιιν γηα ηελ πξνζνκνίσζε εθθίλεζεο θηλεηήξσλ επαγσγήο ζε 

ηξηθαζηθά ζπζηήκαηα. Σν παθέην πξνγξακκάησλ PSS/E, επεηδή απνηειεί έλα εμαηξεηηθά 

δηαδεδνκέλν ππνινγηζηηθό παθέην, ζα ην εμεηάζνπκε αλαιπηηθά ζηελ επόκελε ελόηεηα.  

 

΢ε ό,ηη αθνξά ηώξα ζηα εθπαηδεπηηθά παθέηα, απηά έρνπλ ιηγόηεξεο απαηηήζεηο σο πξνο ηελ 

απνηειεζκαηηθόηεηα θαη ηελ επίδνζε αιιά είλαη πεξηζζόηεξν θαηαλνεηά θαη εύρξεζηα. Γύν 

ηέηνηα πξνγξάκκαηα είλαη ην MATPOWER θαη ην POWERWORLD SIMULATOR. Σν 

MATPOWER είλαη έλα παθέην ηνπ Matlab γηα ηελ επίιπζε ξνήο θνξηίνπ θαη βέιηηζηεο ξνήο 

θνξηίνπ. Δίλαη εξγαιείν πξνζνκνίσζεο, εύθνια ηξνπνπνηήζηκν, κε απιό θώδηθα. Σα 

απνηειέζκαηα δελ απεηθνλίδνληαη ζε γξαθηθό πεξηβάιινλ, αιιά ζε κνξθή πηλάθσλ ζην 

πεξηβάιινλ ηνπ Matlab. Γηα ηελ πξνζνκνίσζε, εηζάγνληαη ηα απαξαίηεηα δεδνκέλα ζε έλα 

αξρείν, θαη ελεξγνπνηνύληαη κέζσ ζπγθεθξηκέλσλ εληνιώλ νη δηαδηθαζίεο επίιπζεο. Σν 

POWERWORLD ζα εμεηαζηεί αλαιπηηθά ζηε ζπλέρεηα, θαζώο απνηειεί ην πξόγξακκα πνπ ζα 

ρξεζηκνπνηήζνπκε ζην εξγαζηήξην. 

 

 

4. PowerWorld Simulator 
 

 Σν πξόγξακκα πξνζνκνίσζεο PowerWorld είλαη έλα αξθεηά εύρξεζην εξγαιείν θπξίσο 

εμαηηίαο ηεο γξαθηθήο παξνπζίαζεο ηνπ ζπζηήκαηνο θαη ησλ απνηειεζκάησλ, είλαη πνιύ 

θαηαλνεηό γηα ηελ εθκάζεζε θαη εμάζθεζε ζε ζπζηήκαηα ειεθηξηθήο ελέξγεηαο. Ζ 

εθπαηδεπηηθή ηνπ κνξθή είλαη δηαζέζηκε ζηελ ηζηνζειίδα www.powerworld.com θαη κπνξεί 

λα πξνζνκνηώζεη 12 δπγνύο. ΢ηελ πιήξε ηνπ κνξθή ην πξόγξακκα απηό πεξηέρεη έλα παθέην 

http://www.powerworld.com/
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αλάιπζεο ξνήο θνξηίνπ πνπ κπνξεί λα πξνζνκνηώζεη ζπζηήκαηα έσο 100.000 δπγώλ. Σν 

γξαθηθό πεξηβάιινλ πεξηιακβάλεη κνλνγξακκηθά δηαγξάκκαηα, ελώ ππάξρεη ε δπλαηόηεηα 

παλνξακηθήο ιήςεο θαη κεγέζπλζεο ζπγθεθξηκέλσλ ζεκείσλ ηνπ ζπζηήκαηνο. Αθόκα, 

πξνζθέξεη εξγαιεία γηα ηε βέιηηζηε ξνή ηζρύνο κε πεξηνξηζκνύο αζθαιείαο, γηα ηε 

δηαζέζηκε ηθαλόηεηα κεηαθνξάο, θαη έλα εξγαιείν γηα ηνλ απηόκαην έιεγρν ηεο παξαγσγήο. 

  

΢ε ό,ηη αθνξά ζηηο δπλαηόηεηεο ηνπ πξνγξάκκαηνο αμίδεη λα αλαθεξζνύλ ηα παξαθάησ: 

 

 Τπνζηεξίδεη ηε ιεπηνκεξή κνληεινπνίεζε κεηαζρεκαηηζηώλ κε ζύζηεκα αιιαγήο ηάζεο ππό 

θνξηίν θαη αιιαγήο θάζεο, δηαθνπηώλ, θακπύισλ ελεξγνύ θαη αέξγνπ ηθαλόηεηαο θόξηηζεο 

γελλεηξηώλ, θακππιώλ θόζηνπο γελλεηξηώλ, πξνγξακκάησλ θνξηίσλ, πξνγξακκάησλ 

αληαιιαγήο ηζρύνο, γξακκώλ ζπλερνύο ξεύκαηνο θαη απνκαθξπζκέλνπ ειέγρνπ ηάζεο 

δπγώλ. 

 Δίλαη δπλαηή ε αμηνιόγεζε όρη κόλν ησλ ηερληθώλ πηπρώλ κηαο αιιαγήο (π.ρ. αλαθαηαλνκή 

θνξηίνπ) αιιά θαη ηεο νηθνλνκηθήο ζεκαζίαο ηεο αιιαγήο. 

 Δλζσκαηώλεη ηνλ απηόκαην έιεγρν παξαγσγήο πεξηνρήο (Automatic Generation Control – 

AGC) ζηελ επίιπζε ηεο ξνήο θνξηίνπ, πξνζθέξνληαο ηξεηο δηαθνξεηηθνύο ηξόπνπο ειέγρνπ: 

κε έλα δπγό ηαιάλησζεο, δηαλεκεκέλν έιεγρν κε πνιιαπινύο δπγνύο ηαιάλησζεο (κε ρξήζε 

ησλ ζπληειεζηώλ ζπκκεηνρήο ησλ δπγώλ) θαη νηθνλνκηθή θαηαλνκή θνξηίνπ. Σαπηόρξνλα, ν 

ηύπνο ηνπ ειέγρνπ AGC είλαη δπλαηόλ λα δηαθέξεη από πεξηνρή ζε πεξηνρή (πρ δπλαηόηεηα 

ρξεζηκνπνίεζεο ηεο νηθνλνκηθήο θαηαλνκήο θνξηίνπ ζε εθείλεο κόλν ηηο πεξηνρέο όπνπ είλαη 

γλσζηέο νη πιεξνθνξίεο γηα ηηο δαπάλεο). Ζ ρξήζε ηνπ ειέγρνπ AGC θαζηζηά ηε δηαδηθαζία 

ηεο επίιπζεο ζαθώο γξεγνξόηεξε. 

 ΢ηε γξαθηθή απεηθόληζε ηνπ ζπζηήκαηνο θαη ησλ ξνώλ θνξηίνπ, ηα βέιε ζηηο γξακκέο, ζηα 

θνξηία θαη ζηηο γξακκέο κεηαθνξάο είλαη κεγαιύηεξα θαη θηλνύληαη ηαρύηεξα αλάινγα κε ην 

κέγεζνο θαη ηελ θαηεύζπλζε ηεο ξνήο ηζρύνο. Παξάιιεια, κε ηελ ρξήζε ησλ pie charts 

(δηαγξάκκαηα πίηαο), είλαη άκεζε ε δπλαηόηεηα ειέγρνπ ησλ ππεξθνξηίζεσλ  ησλ γξακκώλ, 

θαζώο ε ξνή θαίλεηαη σο πνζνζηό ηεο πιήξνπο θόξηηζεο ηεο γξακκήο. 

 Σν εμαηξεηηθά εύρξεζην γξαθηθό πεξηβάιινλ βνεζά ηόζν ζηελ ρξεζηκνπνίεζε ηνπ ίδηνπ ηνπ 

πξνγξάκκαηνο, όζν θαη ζηελ επεμεξγαζία θαη εξκελεία ησλ απνηειεζκάησλ. Μέζα από ηα 

κνλνγξακκηθά δηαγξάκκαηα ηνπ πξνζνκνησηή θαη ηνπο δηαιόγνπο πιεξνθνξηώλ θαζίζηαηαη 

δπλαηή ε δεκηνπξγία θαη ν έιεγρνο ζσζηήο ιεηηνπξγίαο ελόο ζπζηήκαηνο γξαθηθά. Καηά ηε 

ιεηηνπξγία edit mode δεκηνπξγείηαη ή ηξνπνπνηείηαη ην ζύζηεκα, θαη θαηά ηε ιεηηνπξγία run 

mode ην ζύζηεκα «ηξέρεη» θαη νπηηθνπνηνύληαη ηα απνηειέζκαηα. 

 Ζ απηνκαηνπνηεκέλε δηαδηθαζία εηζαγσγήο ζηνηρείσλ (γελλεηξηώλ, γξακκώλ, Μ/΢, θνξηίσλ 

θιπ) έρεη σο απνηέιεζκα ηελ κεγάιε ηαρύηεηα δεκηνπξγίαο ζρεδίσλ, εηδηθά κεηά από κηθξή 

εκπεηξία ρξήζεο ηνπ πξνγξάκκαηνο. Σαπηόρξνλα, είλαη δπλαηή ε ιεπηνκεξήο απεηθόληζε θαη 

αλάιπζε ηνπ ζπζηήκαηνο, θαη ε εύθνιε ρξήζε ησλ ιεηηνπξγηώλ κεγέζπλζεο. 

 Οη δηαθόπηεο ζε νπνηνδήπνηε ζεκείν ηνπ ζπζηήκαηνο αλνίγνπλ ή θιείλνπλ κε έλα απιό 

πάηεκα, γεγνλόο ην νπνίν δηεπθνιύλεη ηδηαίηεξα ηε ζπλνιηθή επνπηεία ησλ αιιαγώλ ή 

πξνβιεκάησλ πνπ πξνθαινύληαη ζην ζύζηεκα κε ηελ απνκόλσζε ή επαλαιεηηνπξγία 

θιάδσλ ή ππνζπζηεκάησλ ηνπ ζπζηήκαηνο (θπξίσο ζε ό,ηη αθνξά ζηηο γελλήηξηεο θαη ζηα 

θνξηία). 

 Παξέρνληαη εξγαιεία γηα ηνλ ππνινγηζκό επαίζζεησλ ζεκείσλ. Γηα παξάδεηγκα, απηά κπνξεί 

λα είλαη νη παξάγνληεο δηαλνκήο κεηαθνξάο ηζρύνο, νη επαηζζεζίεο ξνήο ζηε γξακκή 

κεηαθνξάο, ή ε επαηζζεζία ησλ απσιεηώλ. 

 Γίλεηαη ε δπλαηόηεηα παξαγσγήο ηζνϋςώλ ραξηώλ, νη νπνίνη παξέρνπλ πιεξνθνξίεο γηα ηελ 

πνηθηινκνξθία ησλ ηάζεσλ, ησλ θνξηίσλ, ησλ επαηζζεζηώλ απσιεηώλ θαη ξνήο, ηνπ νξηαθνύ 

θόζηνπο. 



6 

 

 Πεξηέρνληαη εξγαιεία αλάιπζεο πηζαλόηεηαο δηαηαξαρώλ πνπ βνεζνύλ ζηελ αλαγλώξηζε 

πξνβιεκάησλ. Ζ αλάιπζε πηζαλόηεηαο δηαηαξαρώλ γίλεηαη κε ηελ εθαξκνγή κηαο πιήξνπο 

ξνήο θνξηίνπ γηα θάζε πηζαλόηεηα κε απμαλόκελε αθξίβεηα. ΢ηε ζπλέρεηα θαηαξηίδνληαη 

θαηάινγνη ελδερνκέλσλ θαη ζρεηηθώλ παξαβηάζεσλ θαη δίλεηαη ε δπλαηόηεηα ηεο επέιηθηεο 

επεμεξγαζίαο ησλ θαηαιόγσλ ώζηε λα ηθαλνπνηνύληαη δεδνκέλα θξηηήξηα. 

 Γίλεηαη, πέξα από ηε δπλαηόηεηα γξαθηθήο αλαπαξάζηαζεο, θαη ε δπλαηόηεηα παξνπζίαζεο 

θαη επεμεξγαζίαο ησλ ζηνηρείσλ ππό κνξθή πηλάθσλ, ζε ινγηζηηθό θύιιν. Οη πίλαθεο, εθηόο 

από ηηο δπλαηόηεηεο ηαμηλόκεζεο θαη αληηγξαθήο ησλ ζηνηρείσλ, απνηεινύλ έλα εμαηξεηηθά 

ρξήζηκν εξγαιείν γηα ηνλ έιεγρν ησλ δεδνκέλσλ θαη ηπρόλ ιαζώλ, πνπ δελ είλαη πάληα 

εύθνιν λα εληνπηζηνύλ ζηε γξαθηθή αλαπαξάζηαζε. 

 Δίλαη δπλαηή ε απνζήθεπζε ησλ εγγξάθσλ ζε κνξθή HTML, θαη ε εθηύπσζε πςειήο 

επθξίλεηαο δηαγξακκάησλ ζηνλ εθηππσηή. Τπνζηεξίδεηαη ηέινο κηα γιώζζα 

πξνγξακκαηηζκνύ πνπ επηηξέπεη ηελ απηνκαηνπνίεζε ζπρλώλ εξγαζηώλ θαη ηελ νξγάλσζή 

ηνπο, ώζηε λα δηεπθνιύλεηαη ε παξνπζίαζε ησλ απνηειεζκάησλ. 

 

 

4.1. Ειζαγωγή ζηοιχείων / καηαζκευή ηου ζυζηήμαηος (edit mode) 

 

4.1.1. Ζσγός 

 

Σν θπξηόηεξν ζηνηρείν ελόο ζπζηήκαηνο κεηαθνξάο ειεθηξηθήο ελέξγεηαο είλαη ν δπγόο (bus). Οη 

δπγνί ρξεζηκνπνηνύληαη γηα λα απνηππώζνπλ ζεκεία ζπλδέζεσλ ζηνπο ππνζηαζκνύο, όπνπ 

ζπλδένληαη νη δηάθνξεο ζπζθεπέο. Γηα ηελ εηζαγσγή ηνπ δπγνύ επηιέγνπκε από ην κελνύ Draw 

→Network → bus θαη δηαιέγνπκε ηε ζέζε εηζαγσγήο. 

 

 

Εηθ. 4-1 Η ηνπνζέηεζε ελόο δπγνύ ζηελ επηθάλεηα εξγαζίαο 

 

΢ηελ θαξηέια ηνπ δπγνύ πνπ εκθαλίδεηαη εηζάγνπκε ηα δεδνκέλα ηνπ δπγνύ, ηα θπξηόηεξα από ηα 

νπνία είλαη: 

 

 Όλνκα θαη αξηζκόο δπγνύ 

 Μνξθή απεηθόληζεο ζηελ επηινγή display (κέγεζνο, πάρνο, πιάηνο θιπ) 

 Ολνκαζηηθή ηάζε 
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Πιεξνθνξίεο γηα ην αλ ν δπγόο απνηειεί δπγό ηαιάλησζεο ή αλαθνξάο. Ο δπγόο αλαθνξάο, ν 

νπνίνο είλαη δπγόο παξαγσγήο, ρξεζηκεύεη γηα λα αληηζηαζκίδεη ηηο –άγλσζηεο αξρηθά- απώιεηεο 

ηνπ δηθηύνπ θαη γηα ηελ άκεζε αληηκεηώπηζε ησλ κεηαβνιώλ ηζρύνο. ΢’ απηόλ ην δπγό 

επηβάιινπκε ζηαζεξή θαηά κέηξν θαη γσλία ηάζε θαη πξνζδηνξίδνπκε ηηο ηζρείο παξαγσγήο. 

 

Έλαο ηνπιάρηζηνλ δπγόο ην δηθηύνπ πξέπεη λα νξηζηεί σο δπγόο ηαιάλησζεο (slack bus) θαη λα 

νξηζηεί ε γσλία θαη ε ηάζε ηνπ, ζπλήζσο 1ακ κε γσλά 0 κνίξεο. Γηα ηνπο ππόινηπνπο δπγνύο νη 

ηηκέο πνπ νξίδνληαη γηα γσλία θαη ηάζε δελ έρνπλ κεγάιε ζεκαζία θαζώο νη ηηκέο απηέο 

ππνινγίδνληαη θαηά ηελ επίιπζε ηεο ξνήο θνξηίνπ θαη αληηθαζίζηαληαη. ΢ε απηόλ ηνλ δπγό ζα 

πξέπεη νπσζδήπνηε λα ηνπνζεηεζεί γελλήηξηα θαηά ηα πεξηγξαθόκελα ζηελ επόκελε παξάγξαθν.  

Ζ παξαγσγή ηεο γελλήηξηαο απηή αθηέηαη ειεύεζεξε ‘ώζηε λα πάξεη ηελ ηηκή πνπ απαηηείηαη γηα 

ηε ζύγθιηζε ηεο ξνήο θνξηίνπ. 

 

 

 

Εηθ. 4-2 Τα ραξαθηεξηζηηθά ηνπ κελνύ δπγόο(bus) 
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4.1.2. Γεννήηρια 

 

Γηα ηελ εηζαγσγή γελλήηξηαο, αληίζηνηρα κε ην δπγό, επηιέγνπκε ζην κελνύ draw → 

Network→generator θαη δηαιέγνπκε ην δπγό ζηνλ νπνίν ζα εηζάγνπκε ηελ γελλήηξηα.Μάιηζηα ην 

ζρήκα ηεο γελλήηξηαο κπνξεί λα κεηαβιεζεί αλ ζέινπκε λα δείμνπκε π.ρ όηη πξόθεηηαη γηα 

Αλεκνγελλήηξηα. Σν ζρήκα ηεο γελλήηξηαο κπνξεί λα δηακνξθσζεί θαηάιιεια αλάινγα κε ηνλ 

ηύπν ηεο γελλήηξηαο πνπ ζέινπκε λα ρξεζηκνπνηήζνπκε. 

 

΢ηελ θαξηέια εηζαγσγήο δεδνκέλσλ γελλήηξηαο πνπ εκθαλίδεηαη εηζάγνπκε ηα ζηνηρεία ηεο. Σα 

θπξηόηεξα είλαη: 

 

 Σα όξηα ιεηηνπξγίαο ηεο γελλήηξηαο (ειάρηζηε/κέγηζηε παξαγσγή) 

 Παξαγσγή ελεξγνύ ηζρύνο 

 Αλ ε γελλήηξηα ρξεζηκνπνηείηαη από ηνλ απηόκαην έιεγρν παξαγσγήο (AGC) 

 Σν πόζν γξήγνξα αιιάδεη ε παξαγσγή ηεο γελλήηξηαο 

 Αλ έρεη έιεγρν γηα ηε δηαηήξεζε ζηαζεξήο ηάζεο εμόδνπ (AVR) 

 Σα όξηα κέζα ζηα νπνία κπνξεί λα παξαιάβεη ή λα παξάμεη άεξγν ηζρύ 

 Ζ κνξθή απεηθόληζεο (ζηελ επηινγή display) 

 Ο δπγόο ζηνλ νπνίν ζπλδέεηαη ε γελλήηξηα 

  

 

Εηθ. 4-3  ην πεξηβάιινλ εξγαζίαο κεηά ηελ ηνπηζέηεζε γελλήηξηαο 
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Εηθ. 4-4 Τν κελνύ γελλήηξηα 

 

 

4.1.3. Γραμμή μεηαθοράς 

 

Ζ γξακκή κεηαθνξάο ελαιιαζζόκελνπ ξεύκαηνο (AC) ζπλδέεη δύν δπγνύο. Γηα ηελ εηζαγσγή ηεο 

επηιέγνπκε Draw→Network → transmission line. Με ην πξώην θιηθ επηιέγνπκε ηνλ δπγό 

εθθίλεζεο, ζύξνπκε ην πνληίθη κε απιό αξηζηεξό θιηθ θάλνπκε αιιαγή θαηεύζπλζεοο ελώ κε 

δηπιό αξηζηεξό θιίθ ζην δπγό άθημεο ηειεηώλνπκε κε ηελ πξνζζήθε ηεο γξακκήο ζην δίθηπν. 
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Εηθ. 4-5 Η πξνζζήθε δηαζπλδεηηθήο γξακκήο κεηαμύ 2 δπγώλ 

 

΢ηελ θαξηέια πνπ εκθαλίδεηαη κεηά ην ηέινο ηεο ζρεδίαζεο Σα πεξηζζόηεξα από ηα ζηνηρεία ηεο 

θόξκαο ηνπ ΢ρήκαηνο 3 ζπκπιεξώλνληαη απηόκαηα από ην πξόγξακκα κε βάζε ηα άθξα ηεο 

γξακκήο (όπσο απηά νξίζηεθαλ θαηά ηε ζρεδίαζή ηεο), εηζάγνπκε ηα δεδνκέλα ηεο γξακκήο, 

θπξίσο ηα εμήο: 

 

 Ωκηθή αληίζηαζε (R) 

 Δπαγσγηθή αληίδξαζε (X)-ηνπιάρηζηνλ απηή ε ηηκή πξέπεη λα δίδεηαη από ην ρξήζηε 

 Δγθάξζηα ρσξεηηθόηεηα (B) 

 Σα όξηα ηεο ξνήο ηζρύνο 

 Σε κνξθή απεηθόληζεο ηεο γξακκήο 
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Εηθ. 4-6 Τν κελνύ πξνζαξκνγήο ηωλ ηδηνηήηωλ κίαο γξακκήο κεηαθνξάο. 

 

Οη ηηκέο ηωλ παξακέηξωλ R, X θαη B, κπνξνύλ λα δνζνύλ είηε ωο ζπλνιηθέο ηηκέο γηα όιν ην κήθνο 

κήθνο ηεο γξακκήο, ή ωο κεγέζε αλά κνλάδα κήθνπο, κέζω ηεο θόξκαο πνπ εκθαλίδεηαη κε ην 

πάηεκα ηνπ θνπκπηνύ “Calculate Per Unit Impedances”, νπόηε θαη εκθαλίδεηαη ε θόξκα ηεο  

Εηθ. 4-7.. Σηελ πεξίπηωζε ηνπ δηθηύνπ ηνπ παξαδείγκαηνο δόζεθε απεπζείαο ε ζπλνιηθή ηηκή ηεο 

ζύλζεηεο αληίζηαζεο γηα όιν ην κήθνο ηεο γξακκήο 1-2, νπόηε δε ρξεηάδεηαη επέκβαζε ζηε θόξκα 

θόξκα ηεο  

Δηθ. 4-7. 
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Εηθ. 4-7 Τππηθή εηθόλα αλ ηα ζηνηρεία δίλνληαη αλά κνλάδα κήθνπο. 

 

΢ε κηα γξακκή κεηαθνξάο κπνξνύκε αθόκα λα πξνζζέζνπκε έλα «δηάγξακκα πίηαο» (line flow 

chart ή pie chart), ην νπνίν δείρλεη θαηά πόζν ε γξακκή είλαη θνξηηζκέλε ζε ζρέζε κε ην όξην 

καθξάο δηάξθεηαο ξνήο ηζρύνο.Πξνθεηκέλνπ λα γίλεη ζσζηά ε ζπγθεθξηκέλε απεηθόληζε ζα 

πξέπεη ην Limit A λα είλαη ζπκπιεξσκέλν θαη όρη κεδεληθό. Απηό ην όξην είλαη ζπλήζσο ην 

ζεξκηθό όξην ηεο γξακκήο. Κάπνηνη δηαρεηξηζηέο  επηζπκνύλ δηαθνξεηηθά όξηα θόξηηζεο αλάινγα 

κε ηηο εμσηεξηθέο ζπλζήθεο. Έηζη κπνξνύλ λα παξαθνινπζήζνπλ γηα δηαθνξεηηθέο ζπλζήθεο από 

ηηο νλνκαζηηθέο ηε ζπκπεξηθνξά ηεο γξακκήο πνπ παξαθνινπζνύλ. 

 

 Έηζη είλαη πνιύ εύθνινο ν έιεγρνο ησλ ππεξθνξηίζεσλ ησλ γξακκώλ. Γηα ηελ εηζαγσγή ηνπ 

δηαγξάκκαηνο απηνύ θάλνπκε δηπιό θιηθ επάλσ ζηε γξακκή θαη auto insert pie chart. Αθόκα, 

κέζα από ηνλ έιεγρν ηεο κνξθήο απεηθόληζεο ηνπ δηαγξάκκαηνο πίηαο, κπνξνύκε λα νξίζνπκε ην 

κέγεζόο ηνπ, θαζώο θαη λα επηιέμνπκε έλα πνζνζηό θόξηηζεο κεηά από ην νπνίν ζα αιιάδεη ην 

ρξώκα ηνπ δηαγξάκκαηνο, γηα λα καο πξνεηδνπνηεί γηα ηελ αύμεζε ηεο θόξηηζεο ηεο γξακκήο, θαη 

ζα μαλαιιάδεη όηαλ μεπεξλά ηελ ηηκή ππεξθόξηηζεο 100%. 
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Εηθ. 4-8 Τν κελνύ γηα ηελ πξνζζήθε ελεκεξωηηθήο «πίηαο» ζηε γξακκή κεηαθνξάο. 

4.2.  

4.2.1. Μεηαζτημαηιζηής 

 

Ζ εηζαγσγή ηνπ κεηαζρεκαηηζηή απαηηεί ηελ ύπαξμε δύν δπγώλ νη νπνίνη ζα βξίζθνληαη ζε 

δηαθνξεηηθά επίπεδα ηάζεο. Καηόπηλ, από ην κελνύ επηιέγνπκε draw→Network → transformer, 

κε ην πξώην θιηθ επηιέγνπκε ην δπγό πνπ ζπλδέεηαη ην πξσηεύνλ ηνπ κεηαζρεκαηηζηή, θαη κε ην 

επόκελν ην δπγό ηνπ δεπηεξεύνληνο.  

 

 

Εηθ. 4-9 Η πξνζζήθε Μεηαζρεκαηηζηή. 
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΢ηελ θαξηέια ηνπ κεηαζρεκαηηζηή πνπ εκθαλίδεηαη ακέζσο κεηά, εηζάγνπκε ηα δεδνκέλα: 

 

 Λόγνο κεηαηξνπήο ηάζεο (αλ ν ιόγνο είλαη ίζνο κε ην ιόγν ησλ νλνκαζηηθώλ ηάζεσλ 

πξσηεύνληνο/δεπηεξεύνληνο εηζάγνπκε 1) 

 Σξόπνο ειέγρνπ ηνπ Μ/΢ (AVR – απηόκαηνο έιεγρνο, ή έιεγρνο αέξγνπ ηζρύνο) 

 Ωκηθή αληίζηαζε 

 Δπαγσγηθή αληίδξαζε 

 Δγθάξζηα επαγσγηθή αγσγηκόηεηα 

 Σνπο δπγνύο ζηνπο νπνίνπο ζπλδέεηαη θαη ηελ αληίζηνηρε ηάζε ηνπο 

 Σε κνξθή απεηθόληζεο 

  

 

Εηθ. 4-10 Τα δηάθνξα ζηνηρεία πνπ πξέπεη λα  ζπκπιεξωζνύλ γηα έλαλ Μεηαζρεκαηηζηή. 
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4.2.2. Ζσγός θορηίοσ 

 

Δηζάγνπκε θαηαξρήλ ην δπγό κε ηνλ ηξόπν πνπ πεξηγξάθεθε παξαπάλσ (γξαθηθά θαη ζηελ 

θαξηέια). Γηα ηελ εηζαγσγή ηνπ θνξηίνπ, από ην κελνύ επηιέγνπκε Draw→Network → load θαη 

ην ηνπνζεηνύκε ζηνλ δπγό. 

 

 

Εηθ. 4-11 Τν δίθηπν κεηά από ηελ πξνζζήθε ελόο θνξηίνπ 

 

΢ηελ θαξηέια δεδνκέλσλ ηνπ θνξηίνπ, εηζάγνπκε ηα θπξηόηεξα ζηνηρεία: 

 

 Σν όλνκά ηνπ 

 Σν δπγό ζηνλ νπνίν ζπλδέεηαη ην θνξηίν 

 Σελ ελεξγό θαη άεξγν ηζρύ ηνπ 

 Σελ ζύλζεηε αληίζηαζή ηνπ 

 Σελ έληαζε ηνπ ξεύκαηνο 

 Σε κνξθή απεηθόληζήο ηνπ  

 

΢ε απηήλ ηελ πεξίπησζε κπνξνύκε λα έρνπκε 3 δπλαηέο πεξηπηώζεηο γηα ηελ πεξηγξαθή ηνπ 

θνξηίνπ: 

 

 ΢ηαζεξήο ηζρύνο (P,Q ζηαζεξά. Θεηηθή ηηκή ζην Q ζεκαίλεη δήηεζε αέξγνπ ηζρύνο 

(επαγσγηθόο ζπληειεζηήο θνξηίνπ) 
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 ΢ηαζεξνύ ξεύκαηνο (΢ε δύν ζπληζηώζεο ελεξγνύ, αέξγνπ ηξεύκαηνο) 

 ΢ηαζεξήο Αληίζηαζεο (Από σκηθό θαη επαγσγηθό/ρσξεηηθό ραξαθηήξα). Σέηνηα θνξηία 

κπνξεί λα είλαη γηα παξάδεηγκα έλαο ειεθηξηθόο θνύξλνο ή ειεθηξηθό ζίδεξν. 

 

Αλ δεισζνύλ αξηζκνί γηα έλαλ ζπλδπαζκό ζα πξέπεη γηα ηνπο άιινπο δύν νη ηηκέο λα είλαη 

κεδεληθέο. 

 

 

Εηθ. 4-12 Η δηεπαθή γηα ηε κεηαβνιή ηνπ θνξηίνπ 

 

4.2.3. Εγκάρζια Ανηιζηάθμιζη αέργοσ ιζτύος 

 

΢ε έλα ζύζηεκα ειεθηξηθήο ελέξγεηαο ρξεζηκνπνηνύληαη εγθάξζηεο αληηζηαζκίζεηο είηε γηα λα 

παξάγνπλ άεξγν ηζρύ (ππθλσηέο) είηε γηα λα απνξξνθνύλ (επαγσγηθέο αληηδξάζεηο). ΢πλήζσο νη 

ζπζθεπέο απηέο απνηεινύληαη από ζπζηνηρίεο θιηκαθνύκελεο ζύλζεηεο αγσγηκόηεηαο πνπ 

ζπλδένληαη ζην ζύζηεκα κε δηαθξηηά βήκαηα, θαη ε ζπζθεπή ζεσξνύληαη ελεξγέο αλ έζησ θαη 



17 

 

έλα από ηα κπινθ απηά είλαη ζπλδεδεκέλν ζην ζύζηεκα. Αληίζηνηρα κε ηα πξνεγνύκελα, 

επηιέγνπκε ζην κελνύ insert → switched shunt θαη ην εηζάγνπκε ζηε ζέζε πνπ επηζπκνύκε.  

 

Εηθ. 4-13 ην δίθηπν καο κεηά από ηελ πξνζζήθε ελόο ππθλωηή 

 

΢ηελ θαξηέια ησλ ζηνηρείσλ εηζάγνπκε: 

 

 ηα ζηνηρεία ηνπνινγίαο (όπνπ αλήθεη ε ζπζθεπή) 

 ηα ζηνηρεία νπηηθήο απεηθόληζεο (κέγεζνο θιπ) 

 πόζε άεξγε ηζρύ παξάγεη ή θαηαλαιώλεη, θαη αλ είλαη δηαθξηηή (αλ λαη, δίλνπκε θαη ην βήκα). 
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Εηθ. 4-14 Τα ζηνηρεία ηεο εγθάξζηαο αληηζηάζκηζεο 

 

4.2.4. Σύνουη edit mode 

 

Έρνπκε πεξηγξάςεη ηνλ ηξόπν εηζαγσγήο ησλ βαζηθώλ ζηνηρείσλ ελόο ΢ΖΔ. ΢εκεηώλνπκε 

παξαθάησ ζπκπιεξσκαηηθά ηξεηο ζεκαληηθέο δπλαηόηεηεο ηνπ πξνγξάκκαηνο, πνπ ππήξμαλ 

ηδηαίηεξα ρξήζηκεο θαηά ηελ πξνζνκνίσζε. 

 

Οη γελλήηξηεο, νη κεηαζρεκαηηζηέο, ηα θνξηία θαη ηα εγθάξζηα άεξγα ζηνηρεία κπνξνύλ λα 

πξνζδεζνύλ ζηνλ εθάζηνηε δπγό ζηνλ νπνίν ζπλδένληαη. Απηό κπνξεί λα γίλεη ζεκεηώλνληαο ηελ 

αληίζηνηρε επηινγή ζηελ θαξηέια δεδνκέλσλ ηνπ θάζε ζηνηρείνπ. Αλ επηιεγρζεί ε πξόζδεζε 

(anchored), όηαλ πξνζπαζήζνπκε λα κεηαθηλήζνπκε ην δπγό ή ην ζηνηρείν πνπ έρεη πξνζδεζεί 

πάλσ ζην δπγό, ζα κεηαθηλνύληαη θαη ηα δύν ζπγρξόλσο. Με απηόλ ηνλ ηξόπν δηαζθαιίδεηαη ε 

αληηζηνίρεζε ηεο γξαθηθήο αλαπαξάζηαζεο κε απηήλ ησλ δεδνκέλσλ ησλ πηλάθσλ. ΢ην 

παξαθάησ ζρήκα κπνξνύκε λα δνύκε ηε κεηαθίλεζε ησλ ζηνηρείσλ πνπ είλαη ζπλδεδεκέλα ζηνλ 

δπγό 2 όηαλ κεηαθηλείηαη ν δπγόο. 
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Εηθ. 4-15 Η κεηαθνξά/κεηαηόπηζε ζην πεξηβάιινλ εξγαζίαο 

 

΢ε νπνηνδήπνηε ζηνηρείν ηνπ ζπζηήκαηνο έρνπκε ηε δπλαηόηεηα λα παξεκβάιινπκε δηαθόπηεο. Ο 

ξόινο ησλ δηαθνπηώλ είλαη λα απνζπλδένπλ ην ζηνηρείν ή ηε γξακκή κεηαθνξάο, κεηά από 

ζθάικα. Όηαλ νη δηαθόπηεο έρνπλ θόθθηλν ρξώκα ζεκαίλεη όηη είλαη θιεηζηνί (ε γξακκή ή ην 

ζηνηρείν είλαη ζπλδεδεκέλα). Σν πξάζηλν άδεην ρξώκα ηνπ δηαθόπηε δειώλεη όηη ν δηαθόπηεο 

είλαη αλνηθηόο. Δπίζεο κπνξεί ν ρξήζηεο λα αιιάδεη ηελ θαηάζηαζε ηνπ δηαθόπηε θαζώο ην 

πξόγξακκα ηξέρεη, ην νπνίν είλαη ηδηαίηεξα ρξήζηκν, θαζώο θαίλνληαη ακέζσο ηα απνηειέζκαηα 

ζην ζύζηεκα εηζαγσγήο ή απνκόλσζεο ζηνηρείσλ, ή αθόκα θαη ππνκνλάδσλ ηνπ ζπζηήκαηνο. 

 

 

4.2.5. Προζθήκη πληροθοριών και κειμένφν 

 

Σέινο, ζεκεηώλνπκε όηη ππάξρεη ε δπλαηόηεηα εηζαγσγήο θάπνησλ πεδίσλ πιεξνθνξηώλ ζην 

ζρέδηό καο, ώζηε λα είλαη επθνιόηεξε ε επνπηεία ηνπ ζπζηήκαηνο. Έηζη, κπνξνύκε λα εηζάγνπκε 

ηίηιν, ή θάπνην κηθξό θείκελν ζην ζρέδην (insert → text) θαη λα ην επεμεξγαδόκαζηε θαλνληθά 

(ηύπνο, κέγεζνο, ρξώκα γξακκαηνζεηξάο, θόλην θεηκέλνπ θιπ). Αθόκα, γύξσ από ηνπο δπγνύο, 

ηα ζηνηρεία ή ηηο γξακκέο κπνξνύκε λα εηζάγνπκε όπνηα πεδία επηζπκνύκε, ηα νπνία ζα 

ρξεζηκεύζνπλ ζηνλ θαιύηεξν έιεγρν ησλ αιιαγώλ πνπ ζα ζπκβαίλνπλ ζην ζύζηεκα.  

 

Γηα λα γίλεη απηό, θάλνπκε δεμί θιηθ ζην ζηνηρείν, δπγό, ή γξακκή πνπ καο ελδηαθέξεη, 

επηιέγνπκε add new fields around element θαη ην είδνο ηεο πιεξνθνξίαο πνπ ζέινπκε λα 

εηζάγνπκε. Δδώ (ζην παξάδεηγκα αιιά θαη ζην ζύζηεκα ηεο Ρόδνπ) έρνπλ επηιεγρζεί ηα εμήο 

πεδία: 

 

 νη ηάζεηο ησλ δπγώλ 

 ε ηζρύο ζε MW θαη ζε Mvar ησλ γελλεηξηώλ 
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 ν ιόγνο κεηαζρεκαηηζκνύ ησλ κεηαζρεκαηηζηώλ 

 ε ηζρύο ζε MW θαη ζε Mvar ησλ θνξηίσλ 

 ε παξαγσγή αέξγνπ ηζρύνο ζε Mvar ησλ ππθλσηώλ 

 

Σαπηόρξνλα, έρνπλ ηνπνζεηεζεί δηαθόπηεο ζε όιεο ηηο γξακκέο κεηαθνξάο, ηηο γελλήηξηεο, ηα 

θνξηία, ηνπο κεηαζρεκαηηζηέο, ηνπο ππθλσηέο θαη έρνπλ εηζαρζεί ζε όια ηα ζεκεία όπνπ 

βξίζθνληαη δηαθόπηεο ηα πεδία πνπ δείρλνπλ ηηο ξνέο ζε MW. 

 

Έζησ, επηιέγνληαο ηνλ δπγό Β, κε δεμί θιηθ, επηιέγνπκε: Add new fields… ΢ην παξάζπξν 

δηαιόγνπ Insert New Fields… πνπ εκθαλίδεηαη, επηιέγνπκε ηε ζέζε ηνπ πεδίνπ, έζησ Pos1 θαη 

παηάκε ΟΚ. 

 

 

Εηθ. 4-16 Η εηζαγωγή πιεξνθνξηώλ γύξω πό έλαλ δπγό. 
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Εηθ. 4-17 Η δπλαηόηεηα πξνζζήθεο πιεξνθνξηώλ γύξω από δπγό γελλήηξηαο 

 

Δπηπιένλ, κπνξνύκε λα εηζάγνπκε θνπκπηά ειέγρνπ γηα λα κεηαβάιιoπκε βεκαηηθά δηάθνξα 

κεγέζε ηνπ κνληέινπ καο. Γηα παξάδεηγκα, έζησ πσο ζέινπκε ην πξαγκαηηθό θνξηίν ηνπ δηθηύνπ 

καο λα είλαη κεηαβιεηό. Δπηιέγνπκε ην θνξηίν θαη κε δεμί θιηθ επηιέγνπκε: Add new fields…. 

΢ην παξάζπξν Insert New Fields…, επηιέγνπκε ηε ζέζε ηνπ πεδίνπ, έζησ Pos3 θαη παηάκε ΟΚ. 

΢ην παξάζπξν Load Field Options επηιέγνπκε Load MW, ζέηνπκε ην πεδίν Delta per Mouse 

Click: 1,0 (MW) θαη παηάκε ΟΚ. Δπηιέμηε ην πεδίν Include Suffix γηα λα εκθαλίδνληαη θαη νη 

κνλάδεο ηνπ θάζε κεγέζνπο. Δπαλαιακβάλνπκε ηε δηαδηθαζία ζέηνληαο ζηε ζέζε Pos4 ην πεδίν 

Load Mvar κε βήκα 1 Mvar θαη παηάκε ΟΚ. Δμεξρόκαζηε από ην παξάζπξν Insert New Fields…, 

παηώληαο μαλά ΟΚ. 

 

΢εκεηώζηε όηη ην πεδίν delta per mouse click είλαη πξναηξεηηθό λα ζπκπιεξσζεί, απιά καο 

επηηξέπεη λα παξαηεξνύκε ελώ «ηξέρεη» ην πξόγξακκα λα αιιάμνπκε θάπνηα ηηκή θαη λα δνύκε 

ηηο επηπηώζεηο πνπ έρεη ζηα κεγέζε ηνπ δηθηύνπ πνπ εμεηάδνπκε ζε run mode.  Έλα ηέηνην 

παξάδεηγκα παξνπζηάδεηαη ζηελ  παξάγξαθν 4.3.2 
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4.3. Επίλυζη ηου δικηύου (run mode) 

 

Πεξλάκε από ηε ιεηηνπξγία edit mode ζηε ιεηηνπξγία run mode, θαη απηιέγνπκε ζην κελνύ 

simulation → play. Αλ ππάξρεη θάπνην πξόβιεκα ζηελ πξνζνκνίσζε, ην πξόγξακκα δελ ζα 

ηξέμεη, ζα εκθαληζηεί παξάζπξν πνπ ελεκεξώλεη όηη ην ζύζηεκα δελ κπνξεί λα ηξνθνδνηήζεη πηα 

ην θνξηίν, γεγνλόο πνπ ην πξόγξακκα νλνκάδεη blackout. ΢ηε ζπλέρεηα, ζα πξέπεη λα ειεγρζεί 

μαλά ε θαηαζθεπή ηνπ ζπζηήκαηνο, ηα δεδνκέλα θιπ. Αιιηώο, ζα δνύκε ην πξόγξακκα λα ηξέρεη, 

θαη κέζσ ησλ βνεζεηηθώλ πεδίσλ ζα θαηαγξαθνύλ ηα πεδία πνπ έρνπκε επηιέμεη (ηάζεηο, ηζρείο). 

Αλνίγνληαο θαη θιείλνληαο ηνπο δηάθνξνπο δηαθόπηεο, ή απμνκεηώλνληαο ηα θνξηία ή ηηο ηζρείο 

ησλ γελλεηξηώλ, παξαηεξνύκε, ελώ ην πξόγξακκα εμαθνινπζεί λα ηξέρεη, ηηο αιιαγέο πνπ 

επηζπκβαίλνπλ ζην ζύζηεκα, ηηο ππεξθνξηίζεηο γξακκώλ θιπ. ΢ε πεξίπησζε ζπλερόκελεο 

ππεξθόξηηζεο κηαο γξακκήο κπνξεί λα έρνπκε απώιεηά ηεο. ΢ηελ πεξίπησζε απώιεηαο κηαο 

γξακκήο ή γελλήηξηαο, ή ππέξκεηξεο αύμεζεο ηνπ θνξηίνπ, ππάξρεη ελδερόκελν λα παξαηεξεζεί 

δηαθνπή ηεο ιεηηνπξγίαο ηνπ ζπζηήκαηνο. 

 

Παξαθάησ βιέπνπκε πώο ηξέρεη ην κηθξό ζύζηεκα ην νπνίν δεκηνπξγήζακε. Σα βέιε καο 

δείρλνπλ ηε ξνή ηζρύνο ζην ζύζηεκα, ην pie chart δείρλεη ην πνζνζηό ηεο θόξηηζεο ηεο γξακκήο 

ζε amperes, ελώ ν δπγόο 1 έρεη θαζνξηζηεί σο system slack bus. 
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4.3.1. Απεικόνιζη ηης ροής ιζτύος 

 

Αλ ε ξνή ηεο αέξγνπ ηζρύνο δελ είλαη εκθαλήο (κε κπιε βέιε), θάλεηε ηελ θαηάιιειε ξύζκηζε 

από ηελ Edit Mode επηιέγνληαο από ην βαζηθό κελνύ: 

 

Options / Tools -> Oneline Display… -> (Καξηέια) Animated Flows. 

 

΢ην παξάζπξν δηαιόγνπ (Oneline Display Options) πνπ εκθαλίδεηαη, θάλεηε ηηο αθόινπζεο 

ξπζκίζεηο: ΢ην πεδίν Flow Visualization επηιέμηε Actual MW & MVar Power Flow. Δπηιέμηε 

αθόκε ηα πεδία Animation Parameter -> Actual Flow θαη Animate Flow.  

 

 

Εηθ. 4-18 Η δπλαηόηεηα πξνζζήθεο animation γηα λα δνύκ εηε ξνή ηζρύνο. 
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4.3.2. Παράδειγμα μεηαβολής με ηο delta mouse click 

 

΢ην ζπγθεθξηκέλν παξάδεηγκα επηζπκνύκε λα εμεηάζνπκε ηελ επίπησζε πνπ ζα έρεη ε κεηαβνιή 

ηνπ θνξηίνπ θαηά 1MW. ΢ηελ πξώηε πξνζνκνίσζε επηζπκνύκε 9MW θαη ιακβάλνπκε ηελ  Δηθ. 

4-19. Υσξίο λα θιείζνπκε ηελ πξνζνκνίσζε θαη θάλνληαο θιηθ ζηα βειάθηα πνπ εκθαλίδνληαη 

δεμηά ζηελ νζόλε κεηαβάινπκε ην θνξηίν ζηα 10MW, ιακβάλνληαο ηελ Δηθ. 4-1920.  

 

Παξαηεξνύκε ηα εμήο: 

 

Α) Μεηαβνιή ηεο ελεξγνύ ηζρύνο ηεο γελλήηξηαο (αλακελόκελν) αιιά θαη ηεο αέξγνπ ηζρύνο 

ιόγσ ηεο κεγαιύηεξεο ηηκήο ηνπ ξεύκαηνο πνπ ξέεη ζηε γξακκή, ε θόξηηζή ηεο απμήζεθε ζην 

77% άξα θαη ηνπ κεγαιύηεξνπ ξπζκνύ απσιεηώλ ελεξγνπ/αέξγνπ ηζρύνο 

 

Β) Σν κέηξν ηεο ηάζεο πξαθηηθά έκεηλε ακεηάβιεην ζην δπγό ηνπ θνξηίνπ, αιιά κεηαβιήζεθε 

ιίγν ε γσλία. Απηό δειώλεη θαη ηε κεηαθνξά ελεξγνύ ηζρύνο πξνο ην ζπγθεθξηκέλν θνξηίν. 

 

 

Εηθ. 4-19 Πξνζνκνίωζε κε θνξηίν 9MW 
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Εηθ. 4-20 Πξνζνκνίωζε κε θνξηίν 10MW κε ηε ρξήζε ηνπ Delta mouse per click 

 

4.3.3. Η τρήζη ηοσ Model Explorer 

 

Πνιύ ρξήζηκε εθηόο από ηε γξαθηθή απεηθόληζε πνπ είδακε παξαπάλσ είλαη θαη ε ρξήζε ηνπ 

Model explorer ν νπνίνο καο επηηξέπεη ηελ ζπγθξηηηθή παξνπζίαζε ππό κνξθή πίλαθα ησλ 

απνηειεζκάησλ θαη παξακέηξσλ ηνπ δηθηύνπ αλά θαηεγνξία εμνπιηζκνύ,π.ρ. δπγνί, γξακκέο 

θ.ιπ. 

 

Δλεξγνπνηείηαη είηε ζε edit  

Edit mode->Case Information->Model explorer 

 

Δίηε ζε Run Mode 

Run mode->Tools->Model explorer 

 

Καη εκθαλίδεηαη ε νζόλε ηεο Δηθ. 4-21. ΢ην αξηζηεξό ηκήκα θαίλνληαη ηα δηάθνξα ζηνηρεία ηνπ 

δηθηύνπ γηα ηα νπνία ζέινπκε λα ιάβνπκε απνηειέζκαηα. Μπνξνύκε ζηε ζπλέρεηα λα θιείζνπκε 

ηε ζρεηηθή νζόλε γηα λα δνύκε νζόλε όκνηα κε ηελ Δηθ. 4-20. 
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Εηθ. 4-21 Η νζόλε ηνπ Model Explorer 


